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About this Practice Workbook... 

• The Module 10 – Intermediate Corridor Modeling.Zip file will be provided for download. 

• Exact the zip file to the root C:\ 

• All files are then automatically extracted here:   C:\NCDOT Training\Roadway\ Module 10 – 
Intermediate Corridor Modeling 

• With these subfolders: 

 
The Module 10 – Intermediate Corridor Modeling PDF will also be located here. 
 

• This PDF file includes bookmarks providing an overview of the document. Click on the 
bookmark to quickly jump to any section in the file. You may have to turn on the bookmark 
function in your PDF viewer, such as Adobe Reader. 

 

• The dataset used throughout this module uses English units and US Survey Feet. 
 

• Each module in this series is self-contained. You can jump to any module and begin the 
exercises. 

 

• The NCDOT_WorkSets.inp on your desktop should be set the following variables: 
o NCDOT_USE_LOCAL_WORKSETS = L2 
o NCDOT_UNIT_TRAINING_WORKSETS = Roadway 

• This training module uses the DOT-US North Carolina WorkSpace, R-2635C (Training)  
WorkSet and NCDOT_Roadway Role. It is very important that you select the correct 
WorkSpace, WorkSet and Role.  
 

• For more information on setting up workspaces, click here.  
 

• The tool tips and help were copied from the Bentley Online Help. See this link for the 
complete list of tools and common usage. 
OpenRoads Designer CE Help (bentley.com) 
 

• NCLUG/NCDOT Bentley ORD Open X presentations from each NCDOT Department: 
NCLUG - 2022 TECH Talks 

• This workbook was written with the release of OpenRoads Designer 10.10.XX.XX  (2021) 
OpenRoads Designer 2021 R2 update: 

https://gcc02.safelinks.protection.outlook.com/?url=https%3A%2F%2Fconnect.ncdot.gov%2Fprojects%2FRoadway%2FORD%2FNCDOT%2520ORD%2520Flashcard%2520v2023%2520V1.pdf&data=05%7C02%7Carwillets%40ncdot.gov%7C45bb1ff572f54d9f8dd008dcd67fc60e%7C7a7681dcb9d0449a85c3ecc26cd7ed19%7C0%7C0%7C638621091467261192%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C0%7C%7C%7C&sdata=SAyRTASF60V%2FIM9OOdL%2FQqsgfxlKtV9Yq4SWlVOatD0%3D&reserved=0
https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v12/en/GUID-1B18BC16-7361-4DA1-BC57-D8A9EEF3F9E7.html
https://www.nclug.com/page-18079
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OpenRoads Designer  Readme (bentley.com) 
OpenRoads Designer 2021 Release 2 Introduction - YouTube 

• This workbook has been updated for the 2023 Release of OpenRoads Designer 
(23.00.00.129) 

  

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20Readme-v14/en/GUID-43563D21-2E4C-4133-AB04-26E6A4F630EB.html
https://www.youtube.com/watch?v=gWrZETPjxbM
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Overview 
 
The intent of Intermediate Corridor Modeling is to take a basic model/corridor and further develop it 
by adding turn lanes, pavement tapers, and non-typical end conditions. The concept of design intent 
will also be introduced and applied where applicable. In addition to the Corridors Ribbon and the 
Corridor Objects Dialog, the Geometry Ribbon will also play a major role throughout the Intermediate 
Corridor Modeling module. During the exercise, various template point overrides will be introduced 
and applied to override the template point defaults. These overrides will result in the corridor’s 
manipulation. 
 

Corridors Ribbon 
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Geometry Ribbon 
Corridor Objects Dialog 
 
  
 

 

 
 
 
 
 
 

 
Key Concepts, Tools and Terminology 

 
Design Intent 

Design Intent is 
the act of 
preserving 
rules and 
relationships 
established 
during the 
design process 
in order to 
realize 
downstream 
benefits of 
automatic 
updates. 
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Template Point Constraint Overrides 
The location of a template point can be overridden using the various methods shown below. This 
functionality allows a single template to produce a number of results.  
 

• Parametric Constraints - Used to override a default template point constraint within a 
defined station range.  

 

• Horizontal Feature Constraints - Each template point can be assigned one Horizontal Feature 
Constraint that can be used to override the default template point constraint. Horizontal 
Feature Constraints will also override Parametric Constraints. 

 

• Point Controls - Can be applied to any point on a template. A Point Control will force the 
template point to follow a specific linear geometric element. Point Controls will override 
Parametric Constraints and Horizontal Feature Constraints. 

 
Key Stations 
A Key Station may be required when a special circumstance of the project occurs that is not 
coincident with the template interval, requiring additional processing by the corridor. 

 
Feature Definition Toggle Bar  
Activates and deactivates settings that impact a variety of Geometry tools. 

 
Civil AccuDraw Toolbar 
Accesses AccuDraw commands. 
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THE CMD FILE ASSOCIATED WITH THESE EXERCISES HAS A 

DIFFERENT STATIONING FROM THE CORRIDOR ASSIGNED TO IT. 

THIS MUST BE FIXED BEFORE BEING SHIPPED AS IT CAN MAKE IT 

VERY DIFFICULT AND CONFUSING TO DO THE EXERCISES. AS SUCH, 

THE STATIONING IN THIS DOCUMENT LIKELY IS NOT ACCURATE 

Intermediate Corridor Modeling Exercise 
 
In this exercise, you will learn how to take a basic model/corridor and further develop it by adding 
turn lanes, pavement tapers, and non-typical end conditions. You will also be introduced to the 
concept of Design Intent. Design Intent is the act of preserving the rules and relationships used 
during the design process in order to maximize the downstream benefits of automatic updates. 
Throughout this exercise, you will be working with NCDOT 2D dgn files exclusively. All design and 
corridor manipulation will be carried out within a 2-dimensional design plane. 
 
1. Launch OpenRoads Designer CONNECT Edition 
             Double-click on the NCDOT Roadway OpenRoads icon on your desktop to launch 
             OpenRoads Designer into the NCDOT Roadway workspace. 
 
2. Set the Workspace and Workset 
             Select DOT-US North Carolina from the Workspace menu. 
             Select NCDOT R-2635C (Training) from the Workset menu. 

 
 
 
 
 
 

3. Open the Y8 Corridor (CMD) dgn file and zoom in closely to the Y8 Corridor 
A. Click the browse button and path to the Module 10 (Intermediate Corridor Modeling) 

folder and open the R-2635C-RDY-CMD-Y8.dgn file. 

… 
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B. Zoom in near the Y8 alignment as shown below. Notice that the Y8 alignment already has a 
base corridor. This base Y8 corridor will serve as a starting point for the Intermediate Corridor 
Modeling exercise.  See the Initial Corridor Modeling Module for detailed instructions for 
initial corridor development 

Note: All reference files that are required for the intermediate Corridor Modeling module 
have already been attached to the R-2635C-RDY-CMD-Y8.dgn file. 

4. Review the Y8 Corridor Template  
A. Click the Create Template button (Corridors > Create > Template > Create Template) 
B. Under the Project Templates folder, select the Y8_DF - 2+2 Lanes AUX Raised Median 

ADSS template as shown below. You may have to open the training .itl file by clicking 
on the File > Open in the top left. 
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C. Notice a few of the key Y8_DF - 2+2 Lanes AUX Raised Median ADSS template points as shown 
below. Each of these will be used throughout the Intermediate Corridor Modeling exercise. 

D. Examine a brief description of each of these key template points below. The following 
Parametric and Horizonal Feature Constraints associated with these points will be used 
throughout the Intermediate Corridor Modeling exercise.   

 
1. +/~TR_ETO_SHEAR = Target Edge of Travel Outside Shear Null Point 

• Parametric Constraint = PV_Shear_Outside RT/LT 

• Horizontal Feature Constraint = CCE_Target_Shear_Out_RT/LT 
 

2. +/~ETI = Edge of Travel Inside Template Point 

• Parametric Constraint = LN_AUX Inside Width RT/LT 

• Parametric Constraint = LN_AUX Inside Slope RT/LT 

• Horizontal Feature Constraint = CCE_Target_EOT_In_RT/LT 
 

3. +/~LN1 = Lane 1 Template Point 

• Parametric Constraint = MD_Tie Offset 
 

4. +/~ETO = Edge of Travel Outside Template Point 

• Parametric Constraint = LN_AUX Outside Width RT/LT 

• Parametric Constraint = LN_AUX Outside Slope RT/LT 

• Horizontal Feature Constraint = CCE_Target_EOT_Out_RT/LT 
 

5. +/~GSO_N – Grass Shoulder Outside Normal Template Point 

• Parametric Constraint = SHO_Width Normal  

• Horizontal Feature Constraint = CCE_Target_GS 
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E. Close out of the Create Template dialog. 
 
5. Load Civil AccuDraw and the Feature Definition Toggle Bar 

A. Click on the Civil AccuDraw button (Geometry > General Tools > Civil Toggles > Civil 
AccuDraw) to load the Civil AccuDraw toolbar.  

B. Click on the Feature Definition Toggle Bar button (Geometry > General Tools > 
Standards > Feature Definition Toggle Bar) to load the Feature Definition Toggle 
Bar. 

 
Hint: Both of these toolbars will be used throughout the design/modeling process. Because of  
this, it’s recommended that both are docked for easy access.  
 
 

6. Widen the Y8 Corridor median from 30’ to 46’ using a Parametric Constraint 
A. Click the Corridor Objects button (Corridors > Edit > Corridor Objects) 

and select the Y8 Corridor as shown below when prompted to load the  
Corridor Objects dialog. 

 
 
 
 
 
 
 
 
 

B. From the Parametric Constraints row, click the Add New button as shown below. 
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C. Key the following parameters into the Create Parametric Constraint dialog. 

• Start = 9+10.00 

• End = 13+50.00  

• Constraint Label = MD_Tie Offset 

• Start Value = 15.0000 

• Stop Value = 23.0000 
 

D. This will add a median taper and be the first of two (2) parametric constraints necessary to 
widen the median to 46’. 
 
 
 
 

 
E. To better view the changes being made to the Y8 corridor, right-click and hold to load the 

View Control menu. From there, select the 2 Views Plan/3D option as shown below. 
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F. This will load the View 2, Default-3D view in addition to the standard View 1, Default view as 
shown below. As you add parametric constraints, this view can help  visualize the changes 
being made to the Y8 corridor. In order to match the picture below, you may have to View 
Rotation to Top View 
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G. Now, add the following parametric constraint to finish widening the Y8 corridor median to 46’  

• Start = 13+50.00 

• End = Lock to End  

• Constraint Label = MD_Tie Offset 

• Start Value = 23.0000 

• Stop Value = 23.0000 
 

H. The 46’ median has been finalized as shown below. Keep the Corridor Objects dialog open. 
 

7. Add a right turn and bay taper using a Parametric Constraint 
A. Add the following Parametric Constraint using the Corridor Objects dialog. This will add a 12’ 

turn lane on the outer left side of the corridor. 
 

• Start = 7+65.00 

• End = 11+65.00  

• Constraint Label = LN_AUX Outside Width LT 

• Start Value = -12.0000 

• Stop Value = -12.0000 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

B. Notice the right turn bay has been added to the corridor as shown below. 
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C. To finalize the the right turn, add a bay taper using the following Parametric Constraint. 

• Start = 11+65.00 

• End = 12+65.00  

• Constraint Label = LN_AUX Outside Width LT 

• Start Value = -12.0000 

• Stop Value = 0.0000 
 

D. The bay taper has been added and the right turn has been finalized. See below. 
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E. Notice that each of the previous parametric constraints are now listed within the Y8 Corridor 

Objects dialog as shown below. At any time, these values can quickly be changed to reflect  
changes to the design. 

 

 
 

F. Modify bay taper length by keying in +50 to the End Station parameter as shown below. 
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G. Notice that the End Station 
parameter now reads as 
13+15.00, adding an additional 
50’ to the end station. This 
additional 50’ is also reflected in 
the corridor as shown below. 

 
H. Close out of the Corridor Objects dialog. 

 
8. Add a left turn and bay taper using a Horizontal Feature Constraint 

A. With both 2D and 3D views displayed, load the References dialog as shown below. 
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B. Now, click back and forth between the two (2) views. Notice that the Refences dialog 
switches to display the files attached the current view in focus. With the View 1, Defaultview 
in focus, turn the display of the Default-3D view off as shown below.  

 
C. Notice that the 3D model has been turned off, leaving just the linework and the corridor 

object as shown below.  
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D. Depending on your prefence, you may choose to turn off additional linear elements to avoid 
confusion as shown below. The levels displayed below are necessary for design/modeling and 
should remain on as you design/model. 
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E. Next, click the Toggle Civil AccuDraw button ON, set Station-Offset as the 
active Read-Out, and select the first template drop that begins at station 
0+00.00 using the Element Selection tool as shown below. 

 
 

F. Now, click on the trailing template drop arrow shown below and drag the template back and 
forth. Notice the Civil AccuDraw dialog displaying the station/offset data as it tracks your 
movement. 
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G. Key station 6+00.00 into the Civil Accudraw dialog and press Enter. Notice that the corridor 

and all linework associated with it now end at station 6+00.00 as shown below. Then toggle 
Civil Accudraw to OFF. 

 
H. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition 

button and then select the CCE_Target_EOT_In_RT feature from the (Linear > Roadway > 
Construction Class Element) folder as shown below. 

Note: Horizontal features used for targeting are stored within the Construction Class Element 
folder.  
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I. Notice the CCE_Target_EOT_In_RT feature naming convention as shown below. 

 

Note:  
Construction Class Elements are a type of feature commonly used for corridor manipulation but 

not considered part of the actual model.  

 
 

J. From the Geometry tab, select the Single Offset Partial tool (Geometry > Horizontal > Offsets 
and Tapers > Single Offset Partial)  and then select the Y8 alignment when prompted to 
locate element.  
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K. After selecting the Y8 Alignment, the heads-up prompt displays and tracks your movements. 
Notice the  two (2) arrows that are included within the prompt.  These arrows represent 
additional constraints. To toggle back and forth between these constraints, simply click the 
arrow keys on your keyboard. In addition to the heads-up prompt,  a Single Offset Partial 
dialog box also loads. As you toggle back and forth between the constraints, notice that they 
match the  Single Offset Partial dialog constraints. A combination of prompts and dialog 
boxes similar to the ones shown below will be used throughout the design/modeling process.   

 

 
L. With the Parameters Offset prompt toggled on, key-in 3.0000 and press Enter. Notice the 

Lock that displays after you press Enter as shown below. This indicates that the  offset 
parameter has been locked. As you move your mouse back and forth, notice the red dotted 
line tracks with your movements but the offset remains at 3’. If you move your mouse to the 
left side of the alignment, notice that the red line also moves and the offset now reads as -3’. 
The red dotted line represents the CCE_Target_EOT_In_RT that was previously set as the 
active feature. 
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M. Next, toggle to the Distance: Start Distance parameter using your keyboard’s arrow key, then 

key in 6+00.00 and click “Enter” to lock the Start Station as shown below. Notice that these 
same Single Offset Partial dialog parameters have also been locked. The “End” key can be 
used to unlock any of the parameters that have focus if needed.  

 
 Hints: Either of these can be unlocked or modified using the dialog box as well. 
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N. After both Single Partial Offset start constraints have been locked, left click the screen to 
accept. You will then be prompted for a stop location. There are two (2) Stop Constraint 
options to choose from: Length or Station.  Using  your keyboard arrow keys, toggle back and 
forth between the two. In this instance, choose the Distance:End Distance (Station) 
constraint. Key-in station 3+00.00 and press Enter to lock as shown below.  

 
O. Next, left-click the screen to accept the Distance:End Distance constraint. This will place the 

CCE_Target_EOT_In_RT linear element and finalize the left turn lane edge of pavement 
Construction Class Element placement. Immediately after placing this line, you will be asked 
by the prompt if you would like to Mirror. In this instance, key-in N for no, finishing the Single 
Offset Partial command. 
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P. Zoom in close to the CCE_Target_EOT_In_RT line that was just placed and click on it using 

the Element Selection tool. Notice the on-screen constraints displaying stationing, offset, 
and length in relation to the Y8 Alignment as shown below. Each of these constraints 
indicate a rule and can be edited on screen by simply clicking and editing the text.  

 

 
Q. Click on the begin station text that reads 13+00.00 and change it to read 12+50.00. Notice 

that the CCE_Target_EOT_In_RT has been extended by an additional 50’ and the length label 
now reads 350’ as shown below. All of these pieces of geometry are tied to one another 
through a rule. Because of this relationship, if one is changed, all of the others are impacted 
as well. This is the key to rules-based design intent.  

 
 
R. Next, check to make sure that the Persist Snaps and Rule button is toggled on as shown 

below and then select the Variable Offset Taper tool (Geometry > Horizontal > Offsets and 
Tapers > Variable Offset Taper) and again, select the Y8 alignment when prompted to locate 
element. 
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S. Now, key-point snap to the end of the previously drawn CCE_Target_EOT_In_RT element 
and key the following parameters into the Variable Offset Taper dialog. Then, left-click on the 
screen to accept, drawing in the left turn lane bay taper as shown below. Choose not to 
mirror the bay taper when finishing the Variable Offset Taper command.  

• End Offset = 15.0000 

•  Length = 100’ 

 
T. Next, click on the finalized bay taper as shown below and notice the various rule based 

constraints as well as the Key-Point Snap icon. Any time that you snap to an element 
while the Persist Snaps and Rule button is toggled, you create a rule and a relationship 
between the two (2) elements. This establishes a parent-child relationship. In this case, 
the lane line is the parent and the bay taper is the child. 
Note: In some scenarios, this parent-child relationship may be less than desirable but the 
need to snap may still persist. In this case, toggle off the Persist Snaps and Rule option.          
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U. To demonstrate the parent-child relationship between the left turn lane and its bay taper, 
change the length of the left turn lane to 300’ as shown below. Notice that the bay taper is 
also adjusted. This is based on the rule that was established when the bay taper was snapped 
to the end of the lane line during its creation. 

 

 
 

V. After adding the left turn lane and bay taper geometry, turn the Default-3D model back on 
using the references dialog. Notice that the corridor is not recognizing the new geometry  and 
has not changed. To resolve this, the newly added geometry will need to be added to the 
corridor as a corridor reference. To add a corridor reference, click and hover over one of the 
corridor object handles to display the corridor menu. From the menu, select the Add Corridor 
Reference option as shown below. 
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W. Next, select the two (2) new pieces of geometry and then right click to complete. Once the 
corridor finishes processing, it will be updated to include the left turn lane and bay taper as 
shown below. 

 
X. The Left turn lane and bay taper have been added to the Y8 corridor using the 

CCE_Target_EOT_In_RT horizontal feature constraint. For a better perspective, open 
the View 2, Default-3D view as shown below. 

 

 
9. Add a right turn and bay taper using a Point Control 

A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition 
button and then select the CCE_Target_1 feature from the (Linear > Roadway > Construction 
Class Element) folder. Notice the additional CCE_Target features as shown below.  
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Note: By definition, the intent of a point control is to control points. Unlike a Horizontal 
Feature Constraint, which is template based and pre-determined, a point control could be 
used to control any number of the points that make up a template. For this reason, the 
CCE_Target features provided by NCDOT are more generic in nature and a good choice for 
use with a point control. 

 
B. From the Geometry tab, select the Single Offset Partial tool (Geometry > Horizontal > Offsets 

and Tapers > Single Offset Partial)  and then select the Y8 alignment when prompted to 
locate element.  

 
Note: Construction class elements used for template targeting should be created using offsets 
and tapers from the corridor alignment or other non-template based elements to avoid what 
is known as a circular reference. Circular references cannot be targeted by the template, 
making them unusable. 

C. Key the following parameters into the Single Offset Partial dialog and then click through the 
prompts to accept. This will draw the outside edge of travel for the right turn lane. 

• Offset = 51.0000 

• Use Spiral Transitions = Unchecked 

• Start Distance = 6+00.00 

• End Distance = 2+00.00 
 

Notice the Name attribute within the Single Offset Partial dialog as shown below. As you 
design using the Open Roads Civil Tools, civil geometry elements will be named automatically 
based on the Feature.  
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D. Next, select the Ratio Offset Taper tool (Geometry > Horizontal > Offsets and Tapers > Ratio 
Offset Taper) and again, select the Y8 alignment when prompted to locate element. 

E. Key the following parameters into the Ratio Offset Taper dialog or as prompted by the 
heads-up display. 
 

• Ratio = 8.33:1  
 

 
 

 
F. Then Key-Point snap to the end of the right turn lane, creating a rule that will control the start 

location. 
 

G. Next, drag your mouse to the left beyond the default outside edge of travel and click the 
screen to finish the Ratio Offset Taper command. Again, no need to mirror in this instance.  
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H. Now, trim the Ratio Offset Taper to the default outside edge of travel using the Trim to 

Element command (Drawing > Modify > Trim to Element) . This will create another rule that 
dictates that the taper will end at the default outside edge of travel.   

I. Next, add a point control using the Create Point Control option (Corridors > Edit > Edits > 
Create Pont Control) as shown below. 
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J. After selecting the Y8 Corridor, key the following parameters into the Create Point 
Control dialog and click through the prompts to accept.  
 

• Start = Lock to Start 

• Sop = Lock to End 

• Control Description = RT OUTSIDE EDGE OF 
TRAVEL 

• Point = +ETO 

• Mode = Horizontal  

• Control Type = Feature Definition 

• Feature Definition = CCE_Target_1 

• Range = 0.0000 

• Priority = 1 

• Horizontal Offset Start = 0.0000 

• Horizontal Offset Stop = 0.0000 

• Use as Secondary Alignment = Unchecked 
  

 
 

Note: This will create a single point control that runs the length of the Y8 Corridor. This point 
control will be initiated If a piece of geometry is referenced to the corridor with the 
CCE_Target_1 feature assigned to it. 

 
K. Notice the solid line shown below that is now displayed. This line represents the 

RT OUTSIDE EDGE OF TRAVEL point control that was just created.  

 
Note: Like other objects created using OpenRoads technology, point controls can easily be 
edited using the Corridor Objects dialog or by clicking and selecting one of the context menu 
options. 
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L. Next, use the Add Corridor Reference tool and add the right turn lane and bay taper to the Y8 
Corridor as a Corridor Reference.  

 

 
M. In the View 2, Default-3D view, notice that the right turn lane and bay taper have been added 

to the Y8 corridor as shown below. 

10. Use a Parametric Constraint to shear the template at the edge of travel 
A. Select the Create Parametric Constraint option (Corridors > Edit > Edits > Create Parametric 

Constraint) as shown below. 
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B. Click on the Constraint Label drop-down from the Create Parametric Constrain dialog and 
notice the four (4) PV_Shear options. Each of these can be used for shearing pavement at the 
edge on travel. In this instance, select the PV_Shear Outside RT option as shown below. 

 
C. After selecting the PV_Shear Outside RT Constraint Label from the drop-down, key the 

following additional parameters into the Create Parametric Constraint dialog and click 
through the prompts to accept.  

 

• Start = 26+00.00 

• Stop = 29+00.00 

• Constraint Label = PV_Shear Outside RT 

• Start Value = 50.0000 

• Stop Value = 50.0000 
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D. Now, zoom in closely to the shear location as shown below. As expected, elements beyond 

the outside edge of travel have been removed as a result of the PV_Shear Outside RT 
parametric constraint. You may notice, however, that the station range of the elements 
removed does not match the PV_Shear Outside RT station range. However, the yellow 
Corridor Object does match the PV_Shear Outside RT station range.  

 
Note: When conditions occur that are not coincident with the project template interval, it 
might be desirable to include an additional station or stations for processing. 

E. This can be resolved by adding what is called a Key Station. Select the Create Key Station 
option (Corridors > Edit > Edits > Create Key Station) as shown below. 
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F. Create two (2) Key Stations as shown below. Notice that the Key Stations nearly match the 
station parameters for the PV_Shear Outside RT Horizontal Feature Constraint. Key Stations 
should be placed as close as possible but not directly on top of conditions that need to be 
picked up by the corridor.  
 

• Key Station 1 = 35+99.99 

• Key Station 2 = 39+00.01 
 

 
 

G. Notice that the Key Stations did in fact resolve the issue. The Y8 Corridor now reflects the 
intent of the PV_Shear Outside RT Parametric Constraint as shown below.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

KEY STATION 
35+99.99 

KEY STATION 
39+00.01 
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H. The Y8 Corridor shear has been finalized as shown below. 

 
11. Use a Horizontal Feature Constraint to shear the template at the edge of travel 

 
A. From the Feature Definition Toggle Bar, toggle on the Use Active Feature Definition 

button and then select the CCE_Target_Shear_Out_RT feature from the (Linear > Roadway > 
Construction Class Element) folder.  

 
 
 
 

 
B. Next, select the Single Offset Partial tool (Geometry > Horizontal > Offsets and Tapers > 

Single Offset Partial)  and then select the Y8 alignment when prompted to locate element.  
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C. After selecting the Y8 Corridor, key the following 

parameters into the Single Offset Partial 
dialog and click through the prompts to accept.  
 

• Offset = 50.0000  

• Start Distance = 30+00.00 

• End Distance = 32+00.00 
 

Note: The offset does not need to be 50’. This 
number was used for simplicity.  
 

 
 

D. Next, use the Add Corridor Reference tool to add the  CCE_Target_Shear_Out feature to the 
Y8 Corridor as a Corridor Reference.  

 
 
 
 
 
 
 
 
 

E. Notice that the corridor has been sheared as shown below. Again, notice that the shear does 
not match the CCE_Target_Shear_Out feature perfectly and will require Key Stations to be 
finalized. 
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F. Create two (2) Key Stations as shown below.  
 

• Key Station 1 = 39+99.99 

• Key Station 2 = 42+00.01 
 

G. The Y8 Corridor shear has been finalized as shown below. 
 
 

 
 
 
 
 
 

12. Draw Guardrail and TL-3 Anchor units using 3D Linestyles  
A. Select the 2 Views Plan/3D option from the View Control context menu to open the View 

2,Default-3D view in addition to the already opened View 1, Default 2D view.  
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B. From the Feature Definition Toggle Bar, toggle the Use Active Feature Definition button 
and set the Guardrail_Right feature (Linear > Roadway > Guardrail and Barrier > 
Guardrail_Right) to active.  

 

 
C. In the View 1, Default window zoom in closely to the Y8 corridor as show below.  

 
D. Now, select the Line Between Points tool (Geometry > Horizontal > Lines > Line Between 

Points) as shown below. 
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E. Next, draw a random line in the View 1, Default window as shown below. Notice that model 
has not been updated to reflect the guardrail in the View 2, Default-3D window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

F. This can be resolved by toggling on the Create 3D Automatically option and then redrawing 
the guardrail.  

 
G. When the Create 3D Automatically option is enabled, the guardrail which was drawn in the 

2D view of a model will pick up the vertical attribute from the 3D model automatically as 
shown below. 
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H. Delete the guardrail from the View 1, Default window and notice that it is also removed from 
the 3D model.  

 
I. With the Feature still set to Guardrail_Right and the options still set as shown below, 

select the Single Offset Partial tool (Geometry > Horizontal > Offsets and Tapers > 
Single Offset Partial)  and then select the Paved Shoulder on the right side of the road 
when prompted to locate element. 
 

 
 
 
 
 
 

J. After selecting the Paved Shoulder, key the following parameters into 
the Single Offset Partial dialog and click through the prompts to accept. 
This will place the guardrail .01’ off the paved shoulder line as shown 
below.  
 

• Offset = 0.0100 

• Start Distance = 34+50.00 

• End Distance = 36+50.00 

2034161.8430,726974.2473  2034360.8755,726993.8961 
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K. Next, set the TL3 Approach RT feature (Linear > Roadway > Guardrail and Barrier > TL3 
Approach RT) to active and toggle the options as shown below. 

 
L. Next, select the Ratio Offset Taper tool (Geometry > Horizontal > Offsets and Tapers > Ratio 

Offset Taper)  and then select the Y8 alignment when prompted to locate element.  
 

 
 
 
 
 
 
 
 
 

 
M. Then, key the following parameters into the Ratio Offset Taper dialog and then Key-point 

snap to the beginning of the guardrail. After snapping to the end of the guardrail, adjust the 
location of the TL-3 by moving the mouse back and forth before left-clicking to finalize 
placement.   
 

• Offset = 57.0000 

• Length = 62.0000  
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N. After finalizing the TL-3 approach, set the TL3 Trail RT feature (Linear > Roadway > Guardrail 

and Barrier > TL3 Trail RT) to active and toggle the options as shown below. 
 
 
 

 
O. Now, follow the same steps to draw the TL-3 Trailing end. Only this time, set the Ratio 

parameter to 50:1 before Key-Point snapping to the end of the guardrail.  
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P. Notice that both TL-3 Anchor units along with the guardrail are now visible in the View 2, 

Default-3D window as shown below. 
 

13. Widen Grass Shoulder to Accommodate Guardrail and TL-3 Anchor units 
A. First, set the CCE_Target_GS feature (Linear > Roadway > Construction Class Element > 

CCE_Target_GS) to active and toggle the options as shown below. 

B. Then, select the Single Offset Entire Element tool (Geometry > Horizontal > Offsets and 
Tapers > Single Offset Entire Element) and select the guardrail that was added in the 
previous step when prompted to locate element. This will rule the grass shoulder limits to the 
match the guardrail. 

Note: Construction class elements used for template targeting should be created using offsets 
and tapers from the corridor alignment or other non-template based elements to avoid what 
is known as a circular reference. Circular references cannot be targeted by the template, 
making them unusable.  
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C. Set the Offset parameter to 5.0000 within the Single Offset Entire Element dialog and click 
through the prompts to accept. The CCE_Target_GS will be used to widen the grass shoulder 
as needed to accommodate the guardrail. 

D. Next, select the Single Offset Partial tool (Geometry > Horizontal > Offsets and Tapers > 
Single Offset Partial) and choose the Y8 alignment when prompted to locate element. 

 
 
 
 
 
 
 
 
 

E. Then, set the Length parameter to 65.000 and Key-Point snap to the beginning of the 
CCE_Target_GS line that was created in the previous step. Click through the additional 
prompts to create a line that is ruled to be 65’ in length from the beginning of the guardrail.   
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F. Next, select the Variable Offset Taper tool (Geometry > Horizontal > Offsets and Tapers > 
Variable Offset Taper) and again, choose the Y8 alignment when prompted to locate 
element. 

 
 
 
 
 
 
 
 
 

G. Then, key the following parameters into the Variable Offset Taper dialog and snap to the 
beginning of the CCE_Target_GS line that was just drawn in the previous step.  
 

• End Offset = 59.0000 

• Length = 25.0000  
 

 
H. Now, follow the same steps to draw the CCE_Target_GS feature at the Trailing end of the 

guardrail. 
I. The CCE_Target_GS should now cover the full length of the guardrail and TL-3 anchor units as 

shown below. 
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J. Next, use the Add Corridor Reference tool to add the  CCE_Target_GS features to the Y8 
Corridor as a Corridor Reference.  

 Note: If your corridor does not add the CCE_TARGET_GS as a corridor reference, you may need to 
remove the rules associated with it. Click on the CCE_TARGET_GS line and hover until the quick 
access bar appears. Choose the ruler option, and remove rule at the bottom. 
K. Once the Y8 Corridor processes, notice that the corridor did not completely pick up the 

breaks in the CCE_Target_GS as shown below. 

 
L. To resolve this, add four (4) Key-Stations along the CCE_Target_GS feature at each of the 

breaks using Key-Point snaps as shown below. 

M. In the View 2, Default-3D window, notice the finalized guardrail, anchor units and grass 
shoulder widening as shown below.  

KEY-POINT 
SNAP  
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14. Adjust the Guardrail Station Range to Demonstrate Design Intent 

A. Select the guardrail element as shown below and adjust the begin station to 43+50.00 and 
the end station to 47+50.00.  

 
 
 
 
 
 
 
 
 
 
 
 

B. Notice in the View 2, Default-3D window that not only the guardrail, but also the TL-3 
Anchors as well as the grass shoulder that was widened in the previous step, have also been 
updated. This is due to the rules-based design that was leveraged in the previous steps.  

 
Notes:  

• Design Intent is not required, but if used properly can be advantageous to the overall 
design process.  

• A Parametric Constraint can also widen the shoulder for Guardrail.  
 

 


